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Free Security Utilities from MalwareBytes
by Ira Wilsker

R
egular readers of

this column will

know that in

several previous columns

I had reviewed and

recommended the free

and paid “Pro” versions

of the MalwareBytes

security software. The
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publisher of MalwareBytes also has five free utilities available to perform other

types of security scans, as well utilities to enhance system performance. These

free utilities, some in “beta” or pre- release (not a final version or build), each

perform a different task that PC users may find helpful, if not outright

necessary.

These five free utilities can be downloaded directly from MalwareBytes

at www.malwarebytes.org/products/other_tools. The free utilities available from

MalwareBytes are Chameleon, Malware bytes Anti-Rootkit BETA, StartupLite,

FileASSASSIN, and Reg ASSASSIN.

Much of the worst malware in circulation is purposely designed to protect

itself from removal or destruction by a variety of means; one of the most

common self-protection methods used by this malware is to prevent the running

of anti-malware utilities that could possibly detect and kill the malware. Since

MalwareBytes is one of the most popular free-standing malware detectors and

killers, it is one of the prime targets of the malware authors, who ingeniously

come up with ways to prevent MalwareBytes from installing, loading, and

executing, meaning that if MalwareBytes cannot be installed or run, it cannot

remove the malware. MalwareBytes has created a utility, Chameleon

(malwarebytes.org/products/chameleon), that will often be able to load and run

MalwareBytes on a computer infected with self-protecting malware by tricking

the malware into thinking that an innocent, non-protective program is loading.

Just like the small reptile that can change its colors, Chameleon loads the

MalwareBytes anti-malware program under a variety of different program

names, at least one of which may possibly be able to execute, which would then

be able to detect and neutralize the malware. Chameleon is a 1.37mb file,

downloaded in the common ZIP (compressed) format, which can be

uncompressed (un-ZIPPED) using the native Windows Explorer (file manager)

built into Windows. The instructions provided by MalwareBytes on the

installation and use of Chameleon are simple; first, “Unzip the contents to a

folder in a convenient location.” I created a Chameleon folder on my C: drive

which I used to hold the unzipped Chameleon files. The second instruction

references the built-in Chameleon Help File (CHM, or standard Windows help

file format), “Follow the instructions in the included Chameleon CHM Help File

or, if the help file will not open, simply try to run the files by double-clicking on

them one by one until one of them remains open, then follow the onscreen

instructions.” The CHM help file, which is opened by simply clicking or

double-clicking on it to open, displays very simple instructions on how to trick

the malware on the infected computer into allowing the full MalwareBytes

anti-malware utility to install, load, and execute. The CHM Help File says, “Just

click on the first button below and see if it runs. You’ll know it’s working if a

black DOS window appears, slays malicious programs, and then starts

Malwarebytes Anti-Malware. If the first button doesn’t work, try the next one.

If that one doesn’t work, just keep trying until you find one that does! Then use

Malwarebytes Anti-Malware as you normally would to run a Quick Scan and

remove the malware. Click the buttons, one at a time, to attempt to run

Chameleon.” Twelve radio buttons are displayed, aptly named Chameleon #1 to

Chameleon #12, each of which loads a different iteration of Chameleon, one of

which is likely to defeat the self-defense capabilities of the malware, and

allowing the Malware Bytes anti-malware to run and clean the infected

computer.

Since most traditional anti-virus software, and some anti-malware software,

only looks at program files and components on the hard drive, malware and

virus authors found a way to avoid detection by writing malware to the
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Windows registry. The registry is a massive database of information and

instructions, that is not normally scanned by most traditional security software.

Another way of malware and viruses hiding from detection is to place their

operating code in a part of the hard drive not normally scanned by security

software, such as in the MBR or “Master Boot Record” of the hard drive.

According to Wikipedia (wikipedia.org/wiki/Rootkit), “A rootkit is a stealthy type

of software, often malicious, designed to hide the existence of certain processes

or programs from normal methods of detection and enable continued privileged

access to a computer.” MalwareBytes has published a free “BETA” (pre-release

or “not totally refined” version) of its Malwarebytes Anti-Rootkit BETA available

for download from malwarebytes.org /products/mbar. According to Malware

Bytes, “Malwarebytes Anti- Root kit BETA removes the latest nastiest rootkits

and repairs the damage they cause. Malwarebytes Anti-Rootkit BETA is cutting

edge technology for detecting and removing the nastiest malicious rootkits.” 

Being a BETA version, a current download has a finite life, with an

expiration date, preventing the BETA from being used for a long period of time;

once expired, a more recent “BETA’ version, or even a final version, may be

downloaded. Since thousands of new malware builds appear every day, this

anti-rootkit utility needs its digital signature files updated frequently, as several

updates are released every day; these updates enable the anti-rootkit software

to detect the latest known rootkits. The scan is very comprehensive, and may

take quite a while to complete, as it scans the sectors of the hard drive, the

installed drivers (a popular place for malware to hide itself), operating system

files, and the registry. Once the scan is completed, any suspected rootkits are

displayed. I recommend checking the box enabling the creation of a restore point

prior to the removal of any rootkits found, just in case a false positive is

encountered, and a legitimate file is incorrectly identified and removed as a

rootkit, the restore point file can be used to bring back whatever was deleted.

A common complaint among PC users regards the slow booting of the

computer when turned on; this is often because too many programs, often

unnecessary, are being loaded each time the computer is booted. Not just does

this slow the boot process, it also consumes system resources, such as memory

and processor capacity, as unneeded programs are always loaded and running.

Microsoft has a crude but effective startup manager built into Windows, the

“MSCONFIG” command invoked by entering the command from the Start - Run

process. The demand and need for easy to use startup managers is so great, that

many PC utilities incorporate a startup manager of some type in their products.

MalwareBytes is now offering its free “StartUpLite” from its website at

malwarebytes.org/products /startup lite. The sole purpose of StartUpLite is to

speed the boot process by eliminating unnecessary programs from the boot

process; a secondary benefit is the improvement of the system’s performance

since fewer programs are loaded and running. The process is simple, as the file

is ready to run when downloaded to a convenient location; no special installation

or configuration is necessary, as StartUpLite is ready to run as downloaded.

Being a “Lite” program, it is small and not very powerful, but it can detect many

of the most common hogs of boot time, allowing the user to remove these

unwanted programs from the boot sequence. The user needs to be aware that

removing a program from the boot sequence does not delete or uninstall the

program itself, but only stops it from loading at boot.

Many users are aware that files that are loaded and running cannot be easily

removed, as they appear to be locked, and inaccessible. FileASSASSIN is a free

utility that can unlock and delete any type of locked file on the computer. While

legitimate files are often locked because they are in use, or are critical system
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files, many varieties of malware and viruses are also locked to add a layer of

difficulty in their removal; FileASSASSIN can unlock and delete these files.

Since necessary system files are often locked in order to protect them from

accidental (or intentional) removal, MalwareBytes includes the following

warning on the FileASSASSIN website: “Warning: Please use caution with

FileASSASSIN as deleting critical system files may cause system errors.” If used

with extreme care, File ASSASSIN can be a very useful utility, but it may not

be appropriate for inexperienced users, as it is too easy to use it to unlock and

delete legitimate required or critical system or data files.

Just as malware can lock files in order to make them difficult to delete,

malware can also lock registry entries for the same reasons. Some of these

locked registry keys have been known to reinstall malware after the actual

malware program files have been deleted. MalwareBytes offers RegASSASSIN

as a free utility to unlock these malware placed locked registry entries by

utilizing a simple two step process. “RegASSASSIN removes malware-placed

registry keys in two simple steps - just reset permissions and delete!” As with

the other ASSASSIN products, MalwareBytes includes the following: “Warning:

Please use with caution as deleting critical registry keys may cause system

errors.”  The RegASSASSIN file is a tiny 63.7kb file that is ready to run when

downloaded, with no further installation. The instructions are simple; first, run

RegASSASSIN by clicking on it to open it. The second and final step is to, “Enter

the registry key you wish to remove or reset and click Delete.” Just as with the

other ASSASSIN products, this may not be for the novice, but for the

experienced user or technician, as it would be too easy to delete a valid registry

key, causing other substantial problems. I strongly recommend using any one

of the many registry backup utilities, or by using Windows’ built in System

Restore function (windows.microsoft.com/en-US/windows-vista /What-

is-System-Restore), which will allow the user to easily recover from an erroneous

registry key deletion.

These are five good free utilities from MalwareBytes. Consider using them as

appropriate, but be sure to use them with appropriate care and responsibility.

Never forget that the three most important words in computing are, “Backup,

Backup, and Backup.”

Websites:
http://www.malwarebytes.org/products/other_tools

http://www.malwarebytes.org/products/malwarebytes_free

http://www.malwarebytes.org/products/chameleon

https://en.wikipedia.org/wiki/Rootkit

http://www.malwarebytes.org/products/mbar/  (anti-Rootkit)

http://www.malwarebytes.org/products/startuplite/

http://www.malwarebytes.org/products/regassassin/

http://www.malwarebytes.org/products/fileassassin

http://windows.microsoft.com/en-US/windows-vista/What-is-System-Restore

Useful Bits & Pieces
by Lorrin R. Garson

Columnist, Potomac Area Technology and Computer Society, MD

Open Garden 

O
pen Garden has nothing to do with horticulture. It’s a technology that

interconnects devices such as smartphones, laptops and tablets to form

a wireless peer-to-peer mesh network for access to the Internet. For

example, by installing Open Garden on your cell phone and laptop (PC and

Mac), your laptop has access to the Internet via your phone when Wi-Fi hot
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spots are not available. If others have Open Garden installed on their devices

you would all share connectivity and bandwidth. It is the digital equivalent of

grazing on the commons. Open Garden provides an “automatic path choice.”

When the software detects multiple Internet connections, it will select the

fastest one available and will switch to another connection if the original slows

or goes off line. The advantage is that it can offload traffic from an overburdened

access route to one less utilized, say from a 3G or 4G connection to an enabled

Wi-Fi___33 connection. 

Currently Open Garden is available for Android, Windows, and Macintosh

operating systems. An iOS version (for the iPhone) is planned for the future. In

principal widespread deployment of this technology could reduce capital

expenditures for wireless carriers such as Verizon, AT&T, Sprint, etc. by

transferring traffic from their cellular circuits to Wi-Fi___33. However, the

carriers might revolt if they perceive they will lose revenue that is not made up

by lower capital investments. It is a complex business situation and no one

knows at this time how the cell phone companies will react or if consumers will

adopt Open Garden. For more information see http://opengarden.com/, http://

opengarden.net/ and http://opengarden.co/story.php.

Improving PC Performance by Adding Memory
Increasing the amount of memory in your PC is the simplest and least

expensive way to improve performance. The procedure is quite simple even for

those who are hardware challenged. These instructions pertain to desktop PCs,

although adding or changing memory in laptops is similar (see

http://www.wikihow.com /Upgrade-YourLaptop%27s-RAM-Memory).

1: Determine how much memory is currently in your computer (instructions for

Windows 7) by: left-click on Start, right-click on Computer, then left-click on

Properties. Under System will be a line “Installed memory (RAM).”

2: Determine how many memory slots are available in your computer. This can

be done by consulting your PC owner’s manual, opening up your computer for

inspection (more on this later), or using one of the tools such as that available

from Crucial.com (see below).

3: Determine how much memory you need. This is rather subjective. Many will

advise “you can’t have too much memory”, but 4-8 GB is probably adequate

for most people. 12-16 GB or more may be advisable for those doing video or

photo editing. For those playing computer games or doing heavy duty

processing, the more the better.

4: Determine the correct memory needed for your computer. Again, this

information should be available in your PC owner’s manual. For example, for

the HP Pavilion HPE h8xt

the memory specified is SO-

D I M M ,  2 0 4 - p i n

DDR3DIMM, PC3-10600

(1333 MHz) DDR3-SDRAM,

Unbuffered, non-EC (64-bit)

DIMMs, 1.5 V memory only.

It is crucial that you buy the

correct memory; there are

many kinds of memory

(DDR, DDR2,  DDR3,

RDRAM, SDRAM, etc.) sold

by numerous vendors

( A m a z o n ,  N e w e g g ,

TigerDirect, Micro Center,
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etc.) including some manufacturers. Companies that sell memory will sometimes

provide a tool you can download that will tell you the type of memory your

computer uses, the number of memory slots available on your machine, etc. For

example see Crucial.com at http://www.crucial.com /store /drammemory.aspx.

It is generally advisable to use exactly the same brand, model with the precise

specifications for all memory rather than just add additional memory.

5: Installing the memory.

1: Unplug everything from the computer, although some recommend leaving

the power cord plugged in to ground the computer, but be certain the

computer is not running.

2: Be sure to ground yourself to the computer case before working on the

machine. Static electricity can seriously damage components of your

computer. It is preferable to use an antistatic wrist strap for this purpose

(see http://en.wikipedia.org/wiki /Antistatic _wrist _strap). These devices

are quite inexpensive.

3: Open up the computer’s case. This will be somewhat different for every

machine. Sometimes a screw driver will be needed.

4: Locate the memory module(s) and carefully remove them, assuming they

are being replaced. Some memory cards have clips at the ends while

others tilt forward or backward to remove. Look carefully and go gently.

5: Snap the new memory module(s) in place taking care to seat them

correctly. Apply pressure evenly across the width of module. Often you

will hear a “click” as the module is seated.

6: Close up the computer and reattach all the peripherals.

7: Boot up the computer and check to verify (step #1) that the computer

“sees” all the memory you installed.

See  http://www.microsoft.com/athome/setup/addmemory.aspx#fbid=jzzxb

LYldz7 for useful infor-mation on this topic from Microsoft.
From the May 2013 issue of PATACS Post, newsletter of the Potomac Area Technology and

Computer Society, MD. Courtesy of APCUG.

Why Rebates, Not Discounts?
Q.  Why do online companies offer rebates instead of just selling a product at a

lower price? It seems like there are always strings attached such as receiving a

rebate check that can only be used to purchase other company products. I love

your weekly newsletter, Mr. M. Keep up the good work.

A.  Companies have various reasons for offering rebates, but in general, there

are three primary reasons: First, the time between the purchase and the rebate

can be several months, a period in which your money is in the company’s

possession, undoubtedly earning interest or working in other ways to its

advantage. This may seem insignificant, but to a company that sells hundreds

of thousands (or millions) of widgets, it can be substantial. 

Second, what better way for a company to obtain your personal data for

subsequent contact or to sell to others than by offering you money (in the form

of a rebate) for your information?

Third, companies know that most people are busy or lazy (or both) and won't

go to the trouble of cutting out a bar code or providing the requisite paperwork
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to obtain a rebate. In this way, the company gets to attract purchasers by

advertising a low price, and in most instances selling an item for a higher price

because the purchaser never applies for the rebate. What a deal!

Q.  Would it be beneficial to purchase a copy of Windows 7 and set it aside for

a future installation? Now that Windows 8 is out, I'm worried that Windows 7

won’t be available a year or two from now. I would appreciate your thinking on

this matter, Mr. M.

A.  While there are no guarantees when it comes to operating systems, it's been

my experience that previous versions of Windows tend to be available for years

after they are no longer the current operating system. For example, Windows

Vista replaced Windows XP in January 2007, more than six years ago, yet if you

search amazon.com, you will find a number of retailers who still have it

available. If history does indeed repeat itself, Windows 7 is going to be available

for many years to come.

Q.  I know this is a weird question, but what is the proper name for the little

mouse pointer?

A.  Weird questions are always welcome here in Mr. Modemville! The object that

moves on the screen when you move the mouse is often called a cursor, although

some annoying purists might argue that technically only the blinking line that

comprises a DOS prompt can be properly called a cursor. For most users, myself

included, the terms “pointer” and “cursor” can be used interchangeably.

A cursor can take several forms. For example, it may change into a small

hand when hovering over a link, or it may become an animated cursor, in the

form of a rotating hour glass, when Windows is in the process of loading a page

or program. (My cousin Leo became an animated cursor once when he got hit in

the head by a golf ball. No damage to the ball, fortunately.)

Mr. Modem’s DME (Don’t Miss ‘Em) Sites of the Month 

Color
This color-matching game is deceptively easy at first, then becomes

progressively difficult. (Wouldn't it be nice if there was a game that started out

difficult and became progressively easier?) Your job is to mouse over the color

wheel to find a matching color for what is displayed. There is one small catch:

Your cursor is tied not to just one point on the color wheel, but to two points and

then four points as the game progresses. To play, click the color wheel, then use

your mouse to match the color on the outside rim of the circle to the color

displayed in the center of the circle. Each round becomes more difficult as you

have more points or colors around the circle to match. When you reach a color

that matches, click to select it. You will then receive a color-matching score.

Highest score, or the first person to get a splitting headache, wins.

http://color.method.ac

HackerWatch
This is a free service that can test your firewall by doing a simple probe

and/or a port scan. The site also tracks general hacking on the Internet so that

you can learn about potentially vulnerable areas of your system.

www.hackerwatch.org/probe

ImageSplitter
Here you will find free tools for tasks you might want to perform on an

uploaded image, such as resizing, converting, splitting or cropping. To use it,

upload an image by clicking the Browse button, locate your file on your

computer and click Upload Image. Once uploaded, you can edit it on one of three

tabs. By default your image will appear on the Convert and Resize tab where
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you can resize the image by changing the values in the width and height fields,

or you can convert it by selecting the desired file type from the drop-down menu.

Other tools allow you to split an image and crop it.

http://imagesplitter.net
Use Promo Code MODEM when entering your 6-month subscription to Mr. Modem's weekly

computer-help newsletter and receive a 7th month for free! Visit www.MrModem.com. 

Overheating: Enemy Number One
by Bob Rankin

www.bobrankin.com

A
reader asks: 'My computer sometimes shuts down at random times. A

friend said it's probably overheating. How can I find out for sure, and

what can be done about overheating?' Read on to learn why heat is your

computer's worst enemy, and how to keep your PC or Mac from being damaged

by overheating...

Signs of Overheating – and What to do
Electronic components in your computer and other devices generate heat. The

harder they work, the more heat they generate. But heat is the mortal enemy

of all things electronic. So it's important to be alert to temperature spikes in

your computer, and take steps to cool it down when necessary.

How can you tell if your computer is overheating, and what can you do to

keep it from frying like an egg? Sudden, inexplicable shutdowns of your

computer are often due to overheating. Other symptoms of overheating include

declining performance after running

processor-intensive tasks for several

minutes or hours. Games may run

sluggishly, video may skip, and response

to mouse clicks may be delayed. More

alarming are sudden software crashes,

random reboots, and the dreaded Blue

Screen of Death. These symptoms may

have multiple causes, but overheating is

one suspect that needs to be confirmed or

eliminated.

The computer's BIOS (Basic

Input/Output System) detects when the

CPU, motherboard, hard drive, or

graphics adapter is approaching its maximum operating temperature and

shuts things down to avoid damaging that vital and expensive part. If you

are experiencing shutdowns, measure your computer's temperatures and do

something to lower them immediately.

Temperature sensors are built into many computer components; the trick

is accessing these sensors to read temperatures. Microsoft Windows and Mac

OS do not have built-in utilities to let users read temperatures. You have to

find third-party software. Fortunately, there are several free temperature-

monitoring utilities. Some can not only monitor temperatures but also do

something to lower them.

SpeedFAN is a long-standing favorite temperature monitoring utility. It also

monitors voltages in various devices and the speed of the fan(s) which cool your

CPU, power supply, and other components. Some motherboards allow users to

control fan speeds while others do not; if fan speed can be controlled, SpeedFan

will do it automatically to optimize the fan's cooling.
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NOTE: Unfortunately, there are sometimes misleading ads on the SpeedFan

website with big “DOWNLOAD” graphics. Be sure to click the Download link

near the top of the page (next to Screenshots). On the next page, look for “The

latest version is...” You’ll find the download link there. 

Open Hardware Monitor is a free system monitoring program for Windows

and Linux computers. It monitors all of the voltage, temperature, fan speeds

and other sensors built into your motherboard, including CPU temperature.

Temperature Monitor 4.6 is a similar utility for Mac computers. It’s part of

a suite of Mac monitoring utilities written by Marcel Bresink, and it’s available

free of charge. This one does not control fan speeds.

CoreTemp is designed for Intel and AMD multi-core CPUs. It can monitor the

temperature in each core in each processor in your system. It also has a logging

feature to record temperatures over variable periods of time.

If you can find a fan-speed controller that works with your system, it will

provide several benefits. First, it will keep the temperature of your CPU and

other components under the critical level, protecting your hardware and

preventing shutdowns. Second, it will extend the life of your fan by running it

only when it’s really needed. Third, it will minimize that irritating noise than

cooling fans often make.

Other Overheating Solutions 
A good rule of thumb is to make sure your CPU temperature is under 70

degrees Celsius, but each processor has a different safe operating range. I

recommend that you see my article What’s Going On Inside My PC? to find out

what hardware is under the hood, and then search for information on the

maximum safe temperatures.

If adjusting the fan speed doesn’t bring the problem under control, there are

several other possible causes for overheating. Dust is a common cause of

overheating. You can buy cans of compressed air to clean the dust out of heat

sinks, fans, and airflow vents. Crack open the system unit every few months and

you’ll be surprised at how much dust accumulates there, and how it affects your

system temps.

Adequate air flow is important. A tower system should be placed so that its

vents are not blocked by desk, wall, or other obstructions. A laptop can be

elevated on a lap pad to allow air to circulate under the machine.

It’s possible that the fans themselves may need to be replaced. If a fan is

noisy, that’s a sign that it’s not working properly. Some components have built-

in fans that can fail. This recently happened to the graphics adapter on my

desktop machine. My computer was shutting down unexpectedly, and SpeedFan

revealed that the temperature of that component was hitting 120 Celsius (about

250 degrees Fahrenheit). After opening the system unit case, I saw that the fan

attached to the graphics card wasn’t spinning. As a temporary workaround, I’m

leaving the case open and cooling things down with a small electric fan that clips

on the side of my desk. Not pretty, but it works.

It could also be that the thermal seal between the CPU and the heat sink

(which draws heat away) is not good. You can remove the heat sink and reapply

thermal grease, but that’s beyond the scope of this article. You can find YouTube

tutorials on how to do that.
Read more at: http://askbobrankin.com/overheating_enemy_number_one

.html#ixzz2c3nwv2WE
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The Tip Corner
by Bill Sheff

Novice SIG Coordinator, Lehigh Valley Computer Group, PA

Mac2008 support

I
f you happen to have Office for Mac 2008 please note.

Microsoft ended support for Office for Mac 2008 on April 9. The company

reminded users in a blog post on their website. Office for Mac 2008 will

continue to function on computers, but Microsoft will no longer be providing

security updates or bug fixes. Users will still be able to download the latest

updates until April 19, 2014. Microsoft, of course, reminded everyone that it’s

a great time to purchase an Office 365 subscription (which includes Office for

Mac 2011) and all future upgrades to the product. Those looking for a free

alternative, might want to consider LibreOffice or Open Office. 

Using the Command Prompt to Reveal Hidden Files 
Some viruses leave behind nasty side effects, even when your antivirus

program has cleaned the actual virus from your computer. If your desktop icons

are missing and your C: drive appears blank, don’t panic — your files haven’t

gone permanently AWOL. Common viruses, such as the Windows 7 Recovery

virus, will hide your files in an attempt to coerce you into paying for the virus’s

removal. When you view your desktop or click on your C: drive, it may appear

that all of your files have been deleted, but they haven’t — the virus has simply

hidden them. You can restore them easily using a simple command prompt trick

that works in Windows XP, Vista, and 7.

1. Click the Start button in the lower left corner of your task bar. 

2. Type cmd in the search box at the bottom of the menu and press Enter. 

3. If you’re using Windows XP, click Run and type cmd into the Run box.

4. Type attrib -s -h -r c:/*.* /s /d and press Enter to execute the command. 

Allow the command to finish executing (it may take a few minutes). When it’s

done, close the command prompt window and check your desktop — your files,

hidden by the virus, have been restored. You can use the same trick to restore

files the virus may have hidden on other drives, including removable storage

such as flash drives and external hard drives; just change the drive letter in the

command above to the drive letter of the storage device with the hidden files.

Tweeting … Instagramming … YouTubed … What Does it All Mean?
So you want a picture of your granddaughter and they said it was Tweeted

and Instagramed. What does any of that even mean?”

For those of us who frequently use social media, we throw around newly-

created verbiage like Tweeted, Facebooked, and YouTubed like everyone should

understand. This is a little list for those of you who even know what a FaceTwit

is. What makes social media different from traditional media like newspapers,

television, radio and film, is that instead of a professional making content like

a video or a story and showing it to the audience, the audience is participating

by making the content.

So here are some handy definitions. 

Facebook is a site with over a billion users so you may have heard of this one.

Facebook is a site that allow you to share what they call status updates – such

as “Having spaghetti for dinner” or “Off to visit Grandma.” The service is also

popular for sharing personal digital photos, links to stories on websites, and

images with inspirational and political quotes. You can also send private

messages, similar to e-mail or text messages, within Facebook. The people you
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choose to interact with on Facebook are called “Friends.” Users add people they

like as friends and “unfriend” those they no longer wish to communicate with.

You may also choose to like “pages” for celebrities, products, stores etc. You’ll

hear people saying they “Facebooked” a photo, meaning they posted a picture

to the site or they “Facebooked” a person, meaning they contacted that person

via Facebook. Facebook may be accessed with your computer, tablet, or phone.

Twitter, this service allows people to share their thoughts – usually in short

sentences. You may also share photographs and links to web sites. You follow

Twitter users to see their updates. The service is popular with news junkies who

follow news outlets for a continuous updates. Many celebrities have large

followings on Twitter. Actor William Shatner has nearly a million and a half

followers, while Ashton Kutcher has over 14,000,000.

You might hear someone say that they “Tweeted” a message. If someone

shares your Twitter message with others, they have re-Tweeted. It can be

exciting for a Twitter user to be re-Tweeted by a celebrity. You will often see the

hashtag symbol # at the bottom of a television screen during a program or movie

(example: #americanidol). The hashtag invites Twitter users to share their

thoughts on the program, using that particular hashtag so it’s easy for others

to find those thoughts and share their own. Programs will often announce that

actors from a show will Tweeting at a certain time and responding to questions

and comments from fans. 

Twitter can be used from a computer, tablet, or smartphone; though it is

more often accessed from a smartphone. 

Instagram, is a photo sharing and editing service that owes its existence to

smartphones and their handy cameras. When you take a picture with your

smartphone, Instagram allows you to edit the photos right on your phone,

adding “artistic” filters. One of the most popular changes is to make digital

photos look like old Polaroid Instamatic prints. The service lets you share the

shots with friends of your choosing. Those photos can also be shared to Facebook

and Twitter. You can access your Instagram account with a computer, but the

service is most frequently used on smartphones and tablets that feature

cameras.

YouTube is a site where people share videos, most of them made by non-

professionals. Users shoot videos on cameras or their smartphones and upload

them to the site where others can watch them. Before YouTube, it was pretty

difficult for someone to just make a video and have the opportunity for millions

of people to view their work. With YouTube, almost anyone can shoot a video

and have the whole world as a potential audience. 

Some users’ videos become so popular that advertisers pay to be featured on

their work. Violinist Lindsey Stirling has nearly 2,000,000 subscribers and

almost 300,000,000 video views. 

YouTube is very popular with musicians, so much so that Billboard is now

including YouTube views into the calculations it uses to determine the most

popular songs on the music charts. The site can also be a treasure trove of older

TV programs, commercials, music etc… It is a unique environment when you

can see cell phone videos of cats right alongside elaborately-produced HD

masterpieces. YouTube can be accessed from computers, tablets and

smartphones.

A major factor is the popularity of all these services is that you can use them

for free.

What Is Memory Card Class?
We all use SD cards. You find them in your camera, MP3 players, and now

especially in tablets. But there are differences in the class of memory cards.
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The class of memory card refers to the speed at which information can be read

and written to the memory card. Some cameras and devices support high-speed

cards, while others will only take advantage of speeds up to a certain point.

While using a faster card than the device supports won’t damage it, you won’t

see any improvement over a slower-speed card. 
From the May 2013 issue of the The LVCG Journal, newsletter of the Lehigh Valley Com-

puter Group in Pennsylvania. Courtesy of APCUG.

Freeware
by Berry F. Phillips

Member, Computer Club of Oklahoma City

D
uring the many years that I have been writing the Computer Hysteria

Column, I have been a strong advocate of using freeware. On my

computer, the only commercial software is my operating system. All the

rest of the software on my system is freeware. Perhaps this frugality has

something to do with my Scottish ancestry or I could be considered just plain

cheap! In any event, 

I have done my best to give my readers some tips on freeware that I have

used on my system that is exceptional. Free software is a valid choice for the

home computer, office computer and Internet server uses. It is very important

to remember that freeware is not cheap or an inferior option. Freeware comes

in two basic types, free software with proprietary (private) code, and open-source

software. Some freeware can be functionally superior to equivalent commercial

software and even of higher quality. 

For example, the Firefox browser was built and developed by a large

distributed workforce as opposed to a small centralized one. A large number of

programmers can contribute a range of skills, and whose input is graded by peer

review. These programs can be tested and developed in a wide variety of

locations and situations. These community based projects would cost millions to

create commercially. The bottom line, free software can be of the highest quality

and should not be considered inferior to commercial products. The products they

generate are among the most successful applications in the world, PHP, MySQL,

Apache, and various types of Linux.

What are the best free programs that work the best? It used to be utilities.

However, today there are many priceless small programs that work better than

the operating systems resident applications. Free software is a viable solution

in every possible area of a computer’s work. The acceptability of freeware is

demonstrated as the standard server solution. Freeware is widely used in PC

security situations. Free versions of popular firewalls, antivirus, and antispy-

ware programs are often accepted as first choice. How do you find the best

freeware to use on your system? 

For years I have recommended Gizmo’s Freeware be bookmarked on your

computer for fast reference when you need fully reviewed and recommended

freeware. In August 2010, PC Magazine  included Gizmo’s Freeware in its “100

Top Websites of 2010.” As of November 2011 it was rated by Alexa in the top

3,000 sites in English speaking countries and in the top 5,000 worldwide with

more than 100,000 people visiting the site every day. It is also the most

bookmarked site under “freeware” at most of the web’s major bookmarking

services.

Gizmo’s Freeware is a community-based site dedicated to keep the site

independent and noncommercial. The site is maintained by hundreds of

volunteers. Freeware is reviewed for safety and performance by these volunteer

editors with comments from users. Gizmo’s best freeware list is available at the

website and has been used for years to locate the best freeware. You can post on
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forums, respond to reviews after using the freeware, and even write review

depending on your computer skills. I would strongly encourage you to bookmark

and visit this website which will save 

you money as well as increase your computer capabilities. 

http://www.techsupportalert.com

I will have to admit that I am “hysterical” about this website.
From the April 2013 issue of  eMonitor, newsletter of the Computer Club of Oklahoma City.

Courtesy of APCUG.

Gizmo's Freeware:

Scan Any Suspicious File, or Windows Process,

 with 40+ Security Products

A
s you probably know, every program that we recommend on Gizmo's site

is checked out by us first, and that includes scanning it with VirusTotal.

This is a web-based system that scans any uploaded file with more than

40 different antivirus products, and if the program we're writing about doesn't

score 100% with VirusTotal, then we don't write about it.

You can use VirusTotal to check your own computer too. The simplest way is

just to head to www.virustotal.com in your web browser and upload any file

you're concerned about. However, did you know there's also an official

downloadable Windows utility that can do this for you automatically, and which

has some extra capabilities that aren't available via the web site?

http://www.techsupportalert .com /content/scan-any-suspicious-file-or-windows-

process-40-products.htm

SkyDrive and Office Web Apps 
by Lynn Page

Editor/Webmaster, Crystal River Users Group, FL

W
ith a Windows Live ID you have access to Microsoft’s Office Web Apps.

This lets you open, edit and share Word, Excel and PowerPoint docu-

ments online using SkyDrive. So you can work with your documents

from any computer whether it has the Office applications installed on it or not.

Go to http://skydrive.live.com in a web browser to log on or sign up for a

Windows Live account. 

Store Office documents on Sky-

Drive to view and edit them in a

browser. Or share documents

stored on SkyDrive by linking to

them in an email, blog or social

network.  

Save to or Upload to SkyDrive
Documents generated on your home computer can be saved to SkyDrive or

uploaded. Use Save & Send to save an existing Word, Excel, or PowerPoint file.

Select Save to Web, Sign in to your Windows Live Account, and then click OK.

Specify a folder on SkyDrive, and click Save As. Type a name for the file and

click Save.  
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I think it is easier to create the document save it on the hard drive and then

upload it to SkyDrive. In the SkyDrive menu bar click Upload. Then either drag

and drop files from your Documents folder to the upload box or browse to and

select them for upload. To open a document in SkyDrive, select the folder where

document is saved, and click the file name.  

Create New Documents in the Web Browser 
With the Office Web Apps you can create Word, Excel, or PowerPoint files

right in a web browser. The Office application doesn’t have to be open or even

installed on the computer.  

Sign into SkyDrive and click the kind of document to create in the Create

drop down menu. In the dialog box type a name for the document and click the

Create button. 

A new document opens for editing in the appropriate Web App. Simply create

the document as you would in the Office application. The Web App will not have

the full features of the Office 2010 application but is familiar.  

Share Files on SkyDrive 
SkyDrive allows you to share your Office documents, photos and other files.

You can share individual files or an entire folder. In SkyDrive locate the folder

or file to share and place a check in the selection box. Click Sharing on the Menu

bar. The default method of sharing is by email. This lets you give specific people

permission to access and even edit your files. Add the email addresses for those

who will be reviewing the files, add a message and click the Share button. To

access the document the recipients must have an account or create one. 

The Post to option places a link to your SkyDrive files on a social media

service like Facebook. I wouldn’t choose this method of sharing as it is open to

any of your friends or their friends if they repost. 

The Get a link sharing option creates a link you can send to others. The

advantage is they do not need to have a SkyDrive account. The disadvantage is

that anyone with the link can access the file. I would use the View only option

for sharing a link. It allows anyone with the link see the file. The View and Edit

link allows anyone with the link to see and edit the shared files. If you select

Public sharing anyone can search for and view the public files.

Share Files on SkyDrive 
SkyDrive allows you to share your Office documents, photos and other files.

You can share individual files or an entire folder.  

In SkyDrive locate the folder or file to share and place a check in the selection

box. Click Sharing on the Menu bar. The default method of sharing is by email.

This lets you give specific people permission to access and even edit your files.

Add the email addresses for those who will be reviewing the files, add a message

and click the Share button. To access the document the recipients must have an

account or create one. 

The Post to option places a link to your SkyDrive files on a social media

service like Facebook. I wouldn’t choose this method of sharing as it is open to

any of your friends or their friends if they repost. 

The Get a link sharing option creates a link you can send to others. The

advantage is they do not need to have a SkyDrive account. The disadvantage is

that anyone with the link can access the file. I would use the View only option

for sharing a link. It allows anyone with the link see the file. The View and Edit

link allows anyone with the link to see and edit the shared files. If you select

Public sharing anyone can search for and view the public files.
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Organize/Manage SkyDrive 
SkyDrive storage can be managed in a similar way as Documents on your

hard drive. A new SkyDrive account will have three folders: Documents,

Pictures, and Public.

Create new folders with the Create drop down menu. Folders can be nested

within these three main folders or added on the main file location. Go to the

location to add a folder, click Create and select Folder from the drop down menu.

Enter a name for the folder and it is all set for storing files. The path to the files

or folders is shown in the title bar. The number in the bottom right corner of a

folder shows the number of files it contains.

If you change your mind about how folders should be organized you can move

them. To move a folder, go to it in SkyDrive. On the Mani menu click Folder

actions and select Move folder to from the drop down menu. In the dialog box

add a new folder or select the location to move the folder. 

The Manage drop down menu is used to manage files. It allow for renaming,

deleting, moving and copying files. The trick is that you must go the folder

containing the file and place a check in the selection box. That opens additional

commands on the Menu bar. 

To move the file place a check in the selection box (top right corner), click

Manage in the Menu bar and select Move to in the drop down menu. In the

dialog box select the location for the file to be moved.

Word Web App
The Home tab contains basic text and paragraph formatting including Styles.

The Insert tab is used to insert tables, pictures, clip art and links. To insert

a table in the Insert Table drop down point to the number of rows and columns

and click. 

Clicking the Picture icon opens Windows Explorer to select a picture to insert

into the document. Browse to and select the picture and click Open. The picture

is uploaded and inserted into the document.  

Clicking the Clip Art icon opens a search box. Type in a description and click

the search symbol. Browse through the clip are pieces, select one and click the

Insert button.  

Once a picture or clip art has been uploaded a Picture Tools Format tab

appears when the graphic is selected. Tools are available to Grow or Shrink the

picture and add a Picture Style.  

The Page Layout tab specifies page setup and paragraph indent and spacing.

Page Setup options include margins, page orientation and size. 

Save the document when it is complete. Clicking Save on the File tab saves

it on your SkyDrive. Clicking Save As allows you to download a copy and save

it on your hard drive. 

Excel Web App
The Home tab has font formatting and alignment, number formatting and

table formatting. The Cell commands allow for insertion or deletion of rows,

columns, cells and new sheets. The Formulas group includes the commonly used

functions. The Data group can refresh the workbook connections and recalculate

or search the workbook to Find something.

Insert Functions, Tables, Charts, and Links from the Insert tab. The number

of charts available is limited but sufficient.  

The View tab has only two options. You can use the standard Editing View

or choose Reading View to look at the data without toolbars.
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PowerPoint Web App 
When creating a PowerPoint presentation on the web app there a very

limited number of themes. In the first dialog box chose a theme. There are also

four customize buttons that change the color scheme. Once the theme has been

set and the Apply button clicked a new presentation opens. 

The Home tab has the Clipboard, Slides, Font, Paragraph and Drawings

groups. The font and paragraph formatting commands are limited to the basic

functions. The number of shapes is limited but you still have styles, fill and

outline. I like the new Delete group as it provides one click option to delete a

slide.

The Insert tab has a New Slide button to open the dialog to select a slide style

to add to the presentation. Adding pictures and clip art is same as in the Word

Web App. Shapes and SmartArt are added in the Illustrations group.

The Text group contains the Text Box icon.

The Design tab offers the same themes and variations shown in creating the

presentation. So if you decide that the selected theme isn’t working change it to

one more suitable. Set the animation on the slide and timing or reorder the

animations on the Animation tab. Slide transitions are limited to none, fade and

push and are controlled on the Transitions tab. The View tab has three

Presentation Views as well as Notes and Comments. The Editing View is the

normal view you would use in PowerPoint with slide icons for selecting or

sorting and the active slide pane. The other options are Reading View and Slide

Show.  
From the March 2013 newsletter of the Crystal River Users Group in Florida. Courtesy of

APCUG.

Windows 8 Hacks
by Preston Gralla

Reviewed by Iris Yoffa
Member, Tucson Computer Society, AZ

W
indows 8 Hacks is a nifty little task-oriented volume. It is not an

overview or introductory text to Microsoft’s latest Operating System.

And granted, much of what is contained within these pages can be

found online. However, I fall into the category of not knowing enough about

Windows 8 and its underpinnings to know what to ask the Great Google to fetch

for me. So I looked through this book and thought it would be a great

instructional guide to learning the ins and outs of customizing this OS. As I

continued to browse, I noticed some of the hacks I was interested in require

Windows 8 Pro or Enterprise to be installed on my machine. Microsoft has

eliminated many of the command-line utilities we all love to use to get “under

the hood” in a new computer’s edition of the OS that’s installed by default.

Sadly, even the first hack, Disable Windows 8’s Lock Screen, just won’t work for

me because gpedit.msc is not accessible on my new laptop. I feel as if I just

bought a cripple-ware computer! But enough whining.

This book contains an abundance of useful step-by-steps for making Windows

8 more efficient for you. Even more important, there are great explanations of

how the particular subject of the hack works. For example, Hack 70: Hack DNS

to Speed up Web browsing (a way to speed up your web browsing using any type

of connection). This hack has a succinct explanation of the Domain Name

System and how to implement the free OpenDNS service on your computer

and/or entire network. It’s simply a matter of changing the DNS addresses in

Internet Protocols on your PC or router. Windows 8 Keyboard Shortcuts are

listed nicely in a table in Hack 38. 
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This is really handy for us non-touchscreen users. Using the keyboard for

direct access to features is so much more efficient than pointing at corners of the

screen and then click-click-click. Hack 39 is a table of Windows 8 Gestures. Hack

44 is all about SkyDrive, what it is, how to use it, and why you should download

SkyDrive for Windows (not the one preinstalled) to gain full functionality. 

I surely miss the Start Menu. I hear I am far from alone in this complaint.

Hack 8 explains how to create a folder that contains a complete listing of all

your installed applications, including the system apps and Win8 apps. 

Pin it to the start menu and drag it into an accessible spot. Double-click the

folder to see the complete list and use the new File Explorer search bar to find

anything quickly. Hack 85 contains instructions for accessing the Win8 secret

administrator account. This account is not subject to the UAC controls. Think

super-user or root on Linux systems.

So once you figure out how to get past your start screen, you’ll find Preston

Gralla’s book a great asset in modifying or optimizing everything Windows 8.

From startup and desktop to networking and security to e-mail, hardware and

the registry, every aspect of the OS is touched upon. 

While the title uses the term Hacks, I consider them 121 gems of hidden keys

to opening up the potential of Win 8. 

About: Windows 8 Hacks: Tips & Tools for Unlocking the Power of Tablets and
Desktops
Publisher: O’Reilly Media  

http://shop.oreilly.com/product /06369 2002 4958.do  

ISBN-13: 978-1449325756

Price: $24.99, $14.45 @ Amazon
From the May 2013 issue of  eJournal, newsletter of the Tucson Computer Society, AZ.

Courtesy of APCUG.

Society News
President’s note:

On Tuesday August 13th we had our annual picnic. Everyone had a ball.

Thank you, Tony, for cooking! The food was fabulous – there are a lot of good

cooks in the group. We had nineteen in attendance and all agreed on that. The

silent auction as usual was fun and brought in some much needed cash. 

Hope to see everyone at next year’s picnic. You know, the more people, the

more fun for everyone.

–Steve Staub

The Lighter Side


